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1. Introduction 
InterIMAGE is an open source, software development initiative that makes part of an 
international scientific cooperation project leaded by the Computer Vision Lab of the 
Electrical Engineering Department of the Catholic University of Rio de Janeiro (PUC-Rio) 
and by the Brazilian National Space Research Institute (INPE).  

InterIMAGE is a multi-platform framework, written in C++, counting currently with 
implementations for LINUX and Windows operational systems. As it will be made clear in 
the next sections, InterIMAGE provides support for the integration of image processing 
operators in the interpretation process and, as such operators are treated as external programs 
by its control mechanism, they can be coded in any computer language, and can even be 
proprietary programs. The InterIMAGE framework offers, nonetheless, a repository of 
operators (http://www.dpi.inpe.br/terraaida), assembled with the software classes and 
functions supplied by the TerraLib library (Câmara et al., 2000).  

InterIMAGE is founded on GeoAIDA (Bükner et al., 2001), developed in the TNT Institute 
(Institut für Informationsverarbeitung) at the Leibniz Hannover University, Germany, and it 
inherited from that system its basic functional design, knowledge structures and control 
mechanisms. As a work in progress, a new graphical user interface, knowledge processing 
functionality and image processing operators are currently being included in InterIMAGE in 
the near future.  

This operation guide refers to a beta version of the system (version 0.09), and it will be 
updated whenever a new version is released. Reports on bugs, requests for further information 
and suggestions of new functionalities should be sent to lvc_inter@ele.puc-rio.br. 

2. Interpretation Process Components 
In Figure 1 the components of the interpretation process in InterIMAGE are depicted. The 
system implements a specific interpretation control strategy that is guided by a knowledge 
model structured into a semantic network. Interpretation control is performed by system’s 
core, which takes as input a set of image data, GIS layers, digital elevation data, or other types 
of georegistered data. 

Throughout scene interpretation the input data are processed with the aid of external programs 
called top-down and bottom-up operators. Top-down operators are responsible for partitioning 
the scene into sub-regions regarded as object hypotheses. Bottom-up operators evaluate the 
hypotheses, discarding or validating them, and resolving eventual spatial conflicts among 
them. At the end of the interpretation process the validated hypotheses become object 
instances. 

The output of the interpretation process is a symbolic description of the scene, consisting of 
an instance network and the label images that correspond to the regions associated to the 
object instances. From those label images the system is able to create different thematic maps 
representing the different levels of concepts in the semantic network.  
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Figure 1. Components of the analysis process, adapted from (Pahl, 2003). 

2.1. Semantic Networks 
A knowledge model in InterIMAGE contains problem specific information used by the 
control process for the interpretation of a scene. It is represented through a semantic network 
(Figure 2) wherein the organization of the nodes is hierarchical, each node can be associated 
to only one superior (father) node and to one or more subordinate (child) nodes. 

Each node in the semantic network corresponds to a class of objects expected to be found in 
the scene. The nodes have attributes, such as the associated top-down and bottom-up 
operators, as well as generic and operator specific parameters.   

 
Figure 2. Attributes of a node of the semantic network in InterIMAGE. 

The links of the network have no explicit semantic meaning, representing either is-a or part-
of relationships, depending on the operations performed by the bottom-up operator attached to 
the higher level node connected to the link.  

The objects found in the scene by the top-down operators are initially regarded as object 
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hypotheses. It is the task of a bottom-up operator to evaluate the hypotheses associated to the 
children of the node it is attached to, creating object instances from the hypotheses validated 
by the operator.  

As they have no children, it makes no sense to attach bottom-up operators to the leaf nodes of 
the semantic network. On the other hand, as it will be clarified in the next section, there must 
be a holistic top-down operator attached to each leaf node. 

2.2. Top-down Operators 
The basic task of a top-down operator is to generate hypotheses of objects for the scene under 
analysis. As those hypotheses are defined over geographic regions, this task is about 
determining regions in the scene where objects of a certain class may occur.  

Top-down operators are executable programs, called by the system’s core during the 
interpretation process. They can in principle process not only images, but also any type of 
georegistered information, including vector data from a GIS database, digital elevation 
models or other types of raster data. 

When the core calls a top-down operator, it passes on to the operator information about the 
limits of the geographical region to be processed. Note that this region of interest (ROI) is 
defined by another top-down operator attached to an ancestor node. Information about the 
ROI consists of its bounding box and a binary raster mask identifying precisely the region 
limits. Furthermore, the core will pass to the operator just a subset (covering only the ROI’s 
bounding boxes) of the image data in the database it has been specified to process. 

A holistic top-down operator implements a specialized method for the detection of a 
particular object class, over input data with specific characteristics. Holistic operators embody 
implicit knowledge about a particular concept (object class) represented by a node of the 
semantic network. The output of such operators consists of a list of regions and a 
corresponding label image in which the exact extent of the regions are defined. Recall that 
those regions are regarded as object hypotheses in the interpretation process. Additionally, 
these operators can assign confidence values to the regions and state those values in the 
output region list, those confidence values can be later used for the evaluation of the 
corresponding hypotheses (by a bottom-up operator).  

Certain nodes of the semantic network can be associated to object classes that can only be 
detected through their structural components, i.e., objects of those classes can only be defined 
through their component objects. A dummy top-down operator should be attached to such 
nodes. The dummy operator will output a single region that is equal to the ROI defined at its 
father node.  

As mentioned in the previous section, holistic top-down operators must be attached to the leaf 
nodes of the semantic network, as those nodes correspond to primitive object classes. 

A special type of top-down operator is a multi-class operator. Those are holistic operators 
capable of detecting objects of different classes. A multi-class top-down operator should be 
attached to nodes in the same hierarchical level, to be precise: they should be attached to two 
or more child nodes of the same parent node. 

At the root node of a semantic network in InterIMAGE – the net’s topmost node – no top-
down operator needs to be defined. In fact, the system will simply ignore the operators 
eventually attached to such nodes. 
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2.3. Bottom-up Operators 
The evaluation of object hypotheses is the task of the bottom-up operators. Bottom-up 
operators are also executable programs, called by the system’s core during the interpretation 
process. The input of such operators is a list of regions, each region associated to one object 
hypothesis. 

A bottom-up operator evaluates hypotheses associated to the child nodes of the semantic 
network node the operator is attached to. Prior to the execution of the operator, the system’s 
core creates a list containing the descriptions of all object hypotheses associated to the child 
nodes. When the operator is called, this list is passed on as an input parameter to the 
respective executable program. Upon execution, the bottom-up operator judges the input 
hypotheses, discarding or validating them. This judgment can be made by rules hard coded 
into the operator or explicitly defined as attributes of the semantic network node. 

Properties of the object hypotheses, such as confidence values or feature values, can be used 
in the judgment process. The validated hypotheses will from then on be regarded as object 
instances.  

It is important to note that the object instances generated by the operator, may, at some later 
point in the interpretation process, be discarded. That will happen if a higher level object 
hypothesis, to which the instances are related is rejected by another bottom-up operator.  

The object instances generated by the bottom-up operator must be spatially disjoined, so it is 
also a task of such operators to resolve eventual spatial conflicts among their original regions, 
reshaping them in order to remove region overlaps. 

The operator should also group the object instances, associating to each group a region that is 
equivalent to the union of its components’ regions. The groups will originate new object 
hypotheses for the semantic network node at which operator was called, substituting the 
original hypothesis, as it will be clarified in the next section. 

The output of a bottom-up operator consists of a description of the new object hypotheses and 
object instances, in addition to two label images, which describe the spatial extent of the 
regions that correspond respectively to the new hypotheses (associated to the node where the 
operator was called), and to the instances (associated to the children nodes). 

The generic bottom-up operator is an operator delivered with the InterIMAGE package. It 
provides a graphical interface through which the user can design complex decision rules (see 
Section 4.3). 

Since the leaf nodes of a semantic network have no children, there are no hypotheses to be 
evaluated at such nodes, and no bottom-up operators need to be attached to those nodes. The 
system will ignore the operators attached to such nodes. 

2.4. Interpretation Control 
The fundamental task of the system’s core is the control of the interpretation process, which 
consists of two complementary steps: the top-down and the bottom-up steps. 

In the top-down step the control process traverses the nodes of the semantic network, from the 
root to the leaf nodes, calling the top-down operators attached to each node. Top-down 
processing will occur in parallel with respect to the semantic network branches. Object 
hypotheses associated to the network nodes are created during this process and organized into 
a hypothesis network.  
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As processing reaches the leaf nodes, the bottom-up step initiates. The control process starts 
visiting nodes in the opposite direction, calling the respective bottom-up operators recursively 
until the root node has been reached and an instance network has been created. In this process 
the object hypothesis are discarded or turned into object instances.  

A more formal description of the interpretation process, derived from (Pahl, 2003, 2008), is 
given below. 

 
Figure 3. Interpretation process flow. Adapted from (Pahl, 2003). 

If N is a generic node, N’ is a subordinate (child) node with respect to N, N” is a child of N’, 
and so on. TN denotes a hierarchically structured network, i.e., a tree, and N’m e N’n stand for 
different nodes in a same hierarchical level of TN. 

Let S be a node of the semantic network TS, and let H and I be nodes of the networks TH and 
TI, created by the interpretation process. H represents a node associated to an object 
hypothesis and I represents a node associated to an object instance. 

Let R represent a region in the scene to which the H or I nodes are associated. R’ is, therefore, 
associated to either H’ or I’. Considering the hypothesis network TH, all R’ associated to 
nodes H’ are subsets of R; considering the instance network TI, all pairs R’m e  R’n  associated 
to nodes I’m e  I’n  are disjoint.  

The objective of the interpretation process is to create an instance network TI and a 
corresponding network of regions TR, by applying the knowledge represented through the 
semantic network TS in the interpretation of region R. Initially a network TH of hypotheses is 
created, gradually the hypothesis nodes H are substituted by instance nodes I, so that at the 
end of the process the network TI is completed.  
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Top-down processing is depicted on the top of Figure 3. It starts from the point where the 
hypothesis node H, associated to the region R and to the semantic network node S, has already 
been created. From this point on, control passes recursively to the S’ nodes.  

Hypothesis nodes H’mi are generated through the execution of a holistic top-down operator 
attached to the semantic node S’m over the region R. The H’mi nodes are associated to the 
partial regions R’mi. If there is no holistic operator attached to S’m, a single hypothesis node, 
H’m1, will be associated to the whole region defined for its superior (father) node H. R’m1 is, in 
this case, is equal to R. If S’m    is a leaf node (has no child nodes), a holistic top-down operator 
must be attached to it. 

If S’m    has subordinate (child) nodes, the procedure described in the previous paragraph will be 
repeated for each H’mi until the semantic network leaf nodes are reached. At that point 
bottom-up processing starts (bottom part of Figure 3), beginning at the parents of the leaf 
nodes. The bottom-up operator attached to S’m will be executed for H’m once all the leaf 
hypothesis nodes H”ni have been created – the n index identifies the direct descendants of 
H’m. The operator will then evaluate the H”ni hypothesis nodes and decide if they will be 
turned into instance nodes I”n or deleted from the network. Additionally, the bottom-up 
operator will make regions R”ni associated to the I”ni nodes disjoined. 

The bottom-up operator will in turn group the nodes I”n and generate new hypothesis nodes 
H’g to which the instance nodes will be linked. The H’g will then be placed in the hypothesis 
network and linked to the node H, and the original node H’m deleted. Control is then passed to 
node H, for the evaluation and grouping of the H’ nodes. Bottom-up processing proceeds until 
the root node of the hypothesis network is processed. At this point the instance network TI is 
completed. 

3. InterIMAGE’s Main Window 
Once the system has been installed, the user should execute the file interimage. The main 
window of InterIMAGE will be shown (Figure 4). 

The elements of the Main Window are: 

1. Menu Bar: the File menu options enable the user to manage InterIMAGE’s projects 
and semantic nets, and to load and save the results of an interpretation project; the 
View menu options enable the user to view the results of an interpretation project; the 
Actions menu contains the commands to start the interpretation process and to control 
stepwise interpretation; the Help menu enables the user to access the Operation Guide 
(this document) and the About screen. 

2. Toolbar: the buttons of the toolbar enable the user to (from left to right) run an 
interpretation project; delete temporary files created by the system during the 
execution of an interpretation project; define the execution strategy (synchronous, 
asynchronous, stepwise); control the execution during a stepwise run of the 
interpretation (Step, Continue, Stop); call decision rules dialogs: for the bottom-up 
operator (downward arrow) and for the top-down operators (upward arrow). 

3. Semantic Net Panel: this area permits the visualization and editing of a semantic 
network. 

4. Node Properties Panel: this area permits the visualization and editing of the properties 
of the selected node of the semantic network. 
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Figure 4. Main Window. 

The functionality of the menu options, toolbar buttons and of the Semantic Net and Node 
Properties panels will be described in more detail in the subsequent sections. 

4. Designing an Interpretation Project 
The File menu (Figure 5) of the Menu Bar enables the user to manage (create, save and edit) 
an interpretation project; to load and save a semantic network; and to load and save the results 
of an interpretation project. 

The functionality of the File menu options are the following: 

1. New Project: opens the Project Editor window (Section 4.1), enabling the user to 
create an InterIMAGE project. 

2. Load Project: loads a previously saved interpretation project file (with gap extension). 

3. Edit Project: opens the Project Editor window, enabling the user to edit the currently 
loaded project. 

4. Load Net: loads a semantic network previously saved in a file (with .net extension). 

5. Save Net: saves the current semantic network into a file (with .net extension). 

6. Load Result: loads the results of a saved interpretation project in an instance network 
file (with imap extension). 

1 
2 

3 4 
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7. Save Result: saves the results of the current interpretation project in an instance 
network file (with.imap extension). 

8. Quit: quits InterIMAGE. 

9. Recently Used Projects: shows shortcuts for the most recently used projects.  

 
 Figure 5. File menu options. 

The subsequent subsections are organized in a way similar to the steps the user should follow 
to create and manage an image interpretation project in InterIMAGE.   

4.1. Creating or Editing a Project 
When the user chooses the New Project or the Edit Project options of the File menu, the 
system opens the Project Editor window (Figure 6). 

The elements of the Project Editor window are: 

1. Project File Panel: in this panel the user should define the name and the full path to 
the interpretation project file, which basically contains all the information defined in 
the Project Editor window (the file will be saved with extension gap).    

2. Related Files Panel:  contains the names of the files/folders used by the system to store 
input information for the interpretation process  (Semantic Net; Fuzzy Sets; Decision 
Tree) or to store the results of such process (Instance Net or Image Map). The system 
will propose the names of such items, and it is recommended that he/she uses the 
proposed names. 

3. Add GeoImage Panel: the user should add the images to be used in the project, filling 
all the fields on this panel.  

After entering the information about an image (Key, File, Type and geographical 
boudaries1), the user should press the Add GeoImage button (button identified by a 
plus sign), and the image, identified by its Key, will be added to the GeoImage List 
panel. There's a button called Load From geoTIFF that enables the user to load 
geographical boundaries automatically from a geoTIFF file. 

The user can see the information about any selected image in the Add GeoImage panel 

                                                 
1 The image’s geocoordinates should be described in the UTM projection. 
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if he clicks on the Edit button. Then the user can re-edit the information if necessary 
clicking on Save button. To remove from the project an image previously added, its 
key should be selected in the GeoImage List panel, and the user should click on the 
Remove GeoImage button (identified by a minus sign). 

The geoimages added thorough this panel will be made available, identified by its Key, 
to the top-down operators (Section 2.2), i.e. the user can latter define which of those 
images will be used by the different operators, attached to the nodes of the semantic 
network. The current version of InterIMAGE accepts only geoimages in the format 
PPM (portable pixel map). Nevertheless, as the top-down and bottom up operators are 
external programs, and can be developed by third parties, particular operators can 
process geoimages of different formats, e.g. TIFF.   

 
Figure 6. Project Editor window. 

4.2. Creating a Semantic Network 
After creating an interpretation project, the user must design the semantic network that 
represents the knowledge model for the particular application. This can be done by creating 
the net from scratch, or by reusing a semantic network designed previously. If the later is the 
case, the existing net should be copied to the name and location of the file defined at the 
Related Files Panel of the Project Editor (Section 4.1). 

1 

2 

3 
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The user can create, copy or delete nodes of the semantic network editing nodes in the 
Semantic Net panel of the Main Window. 

To create a new node the user should right-click an existing node, and select the New Node 
option, such as shown in Figure 7. 

 
Figure 7. Inserting a New Node in the Semantic Network. 

The next step is to set the node’s properties in the Node Properties panel. There are generic 
node properties (that are the same for all nodes), and bottom-up and top-down specific 
properties, which will vary for different operators. 

The generic properties are: 

• BottomUpOperator: defines the node’s bottom-up operator. It must be filled with the 
corresponding operator’s name. At the leaf nodes, this property need not to be set (see 
Section 2.3).  

• Class: defines the class name of the instance nodes associated to the concept. It is used 
for the grouping of regions and for operations carried on in the bottom-up 
interpretation step.  

• Color: defines the color which will represent the node’s region in the labelled image 
as R:G:B. Example: color=”255:255:0” . 

• Debug: defines the kind of debug information to be produced by the system. Its value 
must be one of the following: DebugInfo, NoDebugInfo, TopDown, BottomUp. 

• Max: defines the maximum number of hypotheses allowed for the concept (generated 
in the top-down step). If more than max hypotheses are found by the operator, they 
will all be ignored – as if the operator generated no hypotheses.  

• Min: defines the minimum number of hypotheses allowed for the concept (generated 
in the top-down step). If less than min hypotheses are found by the operator, they will 
all be ignored – as if the operator generated no hypotheses. 

• Name: name of the node (concept) as it will be shown in the semantic net. To avoid 
confusion it is recommended that the Name and Class properties have the same values. 

• Order: defines the order of execution of the top-down operator, with respect to nodes 
on the same level (siblings) of the semantic network. 

• ResultNode: if this property is set, the node will be treated as a leaf node, and eventual 
descendent nodes will be ignored. 
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• TemporalNode: if this property is set, the node will be treated as a temporal node2. 

• TopDownMultiClass: a boolean attribute, which defines that the same top-down 
operator associated to the node will generate hypotheses for more than one node/class, 
in the same hierarchical level (see Sections 2.2 and 7.1.1). 

• TopDownOperator: defines the node’s top-down operator. At the root node this 
property need not to be set (see Section 2.2) 

Next, the user should attach top-down and bottom-up operators for the node. To set the 
bottom-up operator, user should click in the BottomUpOperator button and select one of the 
available operators (Figure 8).  

 
Figure 8. Setting the Bottom-Up Operator . 

A similar operation should be performed to set the top-down operator for the node (Figure 9). 

 
Figure 9. Setting the Top-Down Operator. 

                                                 
2 Although already included in this version of the system, temporal processing will be not described in this 
document. Such description will be made in future versions of the Operation Guide. 
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Usually the operators have some properties whose values should be set by the user. They vary 
depending on the selected operator. Figure 10 shows the input data for the 
TerraAIDA_Shapefile_Import top-down operator. A description of the properties of the 
available operators is available at a folder named Help, within InterIMAGE’s home folder. 

 
Figure 10. TerraAIDA_Shapefile_Import top-down operator’s properties. 

Once the semantic network has been created, the user should choose the option Save Net from 
the File submenu. It is important to save the semantic network with exactly the same name 
expected in the previously defined project file. 

4.3. Designing Decision Rules 
InterIMAGE provides a way to manipulate or evaluate object hypotheses though the so-called 
Decision Rules. The text that follows describes the graphical interface and functions provided 
by the software for the definition of Decision Rules. 

When Decision Rules are defined for the Generic Bottom-Up operator (provided with this 
version of the system), they have the task of evaluating the hypotheses generated by top-down 
operators, either discarding or turning them into object instances (see Section 2.3). Rules 
defined at top-down operators can also be used to evaluate hypotheses, but their outcome are 
also object hypotheses that will be later subjected to evaluation during the bottom-up 
processing step (see Section 2.4). Any operator whose name contains the word Generic has a 
decision rule as a property. 

The Decision Rule Editor (Figure 11) is invoked when the user clicks over the decision rule 
buttons in the Tool Bar or over the decision rule property, in the Node Properties Panel of the 
Main Window (Chapter 3). 

The elements of the Decision Rule Editor are: 

1. Decision Tree / Source Code Panel: this area allows the user to build a decision rule. 
It can be done by adding graphical language elements (decision tree) or writing 
directly the rule in the system’s proprietary reverse polish notation language (source 
code). For information about the RPN language, refer to (Pahl, 2003, 2008). 

2. Elements: these buttons correspond to the basic constituent elements of a decision 
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rule. Each element has a different meaning and functionality, as it will be described in 
the next sections. A left click on the element buttons generates a new rule node on the 
decision tree panel (see section 4.3.1). 

3. General Toolbar: the buttons of the general toolbar enable the user to (from left to 
right): erase the decision tree and initiate a new one; open a dialog where the user can 
select images which will be used in the decision rule; enable the Expert Mode which 
only the Source Code can be edited (in the normal mode only the Decision Tree can be 
edited and the source code is read-only). 

4. Elements Toolbar: these buttons permit the user to interact with the elements. The left 
and right buttons move the selected element through the tree levels. The up and down 
buttons move the selected element through its siblings. There are also default 
clipboard actions (cut, copy, paste and delete) and the last button edits the item 
properties. 

 
Figure 11. Decision Rule Editor. 

4.3.1 Decision Tree Elements 
While building a decision tree it is essential to know the meaning of its constituent elements. 
A basic explanation of these elements is given bellow. 

Join Element: joins or concatenates the list of hypotheses of different classes into a single 
node list. 

1 

3 

4 

2 
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Figure 12. Join example. 

Class Element: selects hypotheses of a specific class. When clicking on it, the insert class 
dialog (Figure 13) shows up and the user can choose one of the classes associated to the 
nodes of the semantic network, or all of them at once. 

 
Figure 13. Insert Class Dialog. 

 
Figure 14. Class example. 

Logic Element: selects the hypotheses that fulfill a given criteria. When clicking on the 
button, the insert logic dialog (Figure 15) shows up and the user can choose an attribute and 
specify the criteria. It also understands mathematical expression. 

 
Figure 15. Insert Logic Dialog. 
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Figure 16. Logic example. 

And/Or Elements: are used to build complex logic structures when associated with a Logic 
Element. 

 
Figure 17. And/Or example. 

Expression Elements: are used to set an attribute. When clicking on it, the expression logic 
dialog (Figure 18) shows up and the user can choose or define an attribute to set a value. It 
also understands mathematical expressions. 

 
Figure 18. Expression Logic Dialog. 

 
Figure 19. Expression example. 

Membership Elements: uses Fuzzy Logic to calculate and aggregate membership values. 
When clicking on it, the membership logic dialog (Figure 20) shows up and the user can 
choose among using a fuzzy set, an operation or a membership value.   

If the fuzzy set is selected the dialog allows the user to create, edit or delete a fuzzy set. When 
the user opts for creating or editing a fuzzy set the Fuzzy Set Interface is enabled (see Section 
4.4). 
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Figure 20. Expression Logic Dialog. 

 
Figure 21. Expression example. 

Aggregate Elements: Aggregates values from selected hypotheses. When clicking on it, the 
aggregate logic dialog (Figure 22) shows up and the user can select an attribute and a 
function with the proper argument. It is possible to pass these aggregated values to the parent 
node in the semantic network hierarchy by choosing the for parent option. 

 
Figure 22. Expression Logic Dialog. 

 
Figure 23. Aggregation example. 

Classify Elements: solves spatial conflicts and classifies the selected hypotheses according to 
their membership values. It is only allowed for bottom-up operators. 

When clicking on it, the classify logic dialog (Figure 24) shows up and the user can choose 
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from a global merge or a neighbors’ merge. In the first case, the original hypothesis, 
associated to the node the bottom-up operator is attached to, is substituted by a single 
hypothesis whose corresponding geographic region is the union of all the regions associated 
to the node’s children hypotheses. In the case of a neighbor merge, the original hypothesis 
will be substituted for as many hypotheses as the contiguous regions formed by clusters of the 
children hypotheses. 

 
Figure 24. Classify Logic Dialog 

 
Figure 25. Classify Example 

4.4. Using Fuzzy Sets 
When adding a Membership Element in a decision rule, the user can specify the 
characteristics of the fuzzy set through the Fuzzy Set Interface (Figure 26). 

The elements of the Fuzzy Set Interface are: 

1. Attribute: defines the attribute to be used in the fuzzy set. 

2. Fuzzy Set: determines the name of the fuzzy set. 

3. Function Type: chooses the function type to be used in the fuzzy set. 

4. Membership Function: specifies the features of the fuzzy set function. The user can 
select the number of points to be defined in the function. The X and Y offsets and the 
maximum and minimum function value can be set also. Depending on the chosen 
function, some parameters can be available. Each one of the number of points defined 
before can be edit on the function box by clicking on it.  The user can drag and drop 
the point or define its coordinates on the X and Y coordinates box. 
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Figure 26. Fuzzy Set Interface. 

5. Running an Interpretation Project 
To run an interpretation project, the user should click on the leftmost button of the Main 
Window’s Toolbar (see Chapter 3), or select the Start option of the Actions menu (Figure 27).  

 
Figure 27. Actions menu options 

Before starting the interpretation process, the user should choose one of the execution 
strategies in the Main Window’s Toolbar (Figure 28) from the following options: 

1. Asynchronous: the default mode. The interpretation process runs asynchronously, that 

1 

2 

3 

4 
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is, the top-down and bottom-up operators are called in an asynchronous fashion, 
respecting only the logical steps defined by the semantic network. For instance, when 
there is more than one node in a certain level of the semantic net, and the 
interpretation is in the top-down step, all the top-down operators attached to the nodes 
in that level will be called simultaneously. Once the processing of one operator has 
finished, the system calls the operators attached to its offspring nodes, and so on. 
Synchronization, however, occurs in the bottom-up processing step, as the system 
waits for all bottom-up processes of the descendants of a node to finish before running 
its bottom-up operator (see Section 2.4). 

2. Asynchronous Stepwise: a stepwise mode that can be used for debugging the 
interpretation project. The system fires the operators in an asynchronous fashion, just 
as in the above option, but as any process finishes, the user must command the system 
to continue by selecting the Next Step option of the Actions menu. If the user selects 
the Continue option, interpretation resumes until the process finishes, or until the user 
selects the Stop option of the Actions menu. 

3. Synchronous: the interpretation processes run synchronously until the end. The 
difference from the asynchronous mode is that the system will fire one operator at a 
time, and wait until the processing of the operator finishes before executing another 
operator. 

4. Synchronous Stepwise: a stepwise mode. Synchronous version of the Asynchronous 
Stepwise mode.  

 
Figure 28. Execution modes. 

6. Visualizing Results 
To visualize the results of the interpretation process, InterIMAGE offers functionalities 
through the View submenu, as shown in Figure 29. 

 
Figure 29. View Menu. 
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1. Scene Viewer: shows the instance network with the selected regions and all their 
available attributes, as shown in Figure 30.  

2. Trash Viewer: shows the rejected regions’ attributes, related to the hypotheses that 
were discarded during the interpretation process (Figure 31). 

3. Map Viewer: shows the resulting label image, with the classified regions. 

4. Debug Image Viewer: shows the label image with the discarded regions (the same 
regions identified in the Trash Viewer. 

5. Task Viewer: shows/hides the Task Viewer panel, which shows the processes started 
by the system (related to the execution of top-down and bottom-up operators). 

 
Figure 30. Scene Viewer. 
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Figure 31. Trash Viewer. 

The Map Viewer shows the label image with the classified regions. It is linked to the Scene 
Viewer, which means that when the user clicks on a region in the map file, the region is 
automatically selected on the Scene Viewer, showing all its attributes. It is possible to zoom in 
and zoom out, to fade the label image, blending with the input image as shown in figure 32. 
 

         

Figure 32. Map Viewer. 

The Map Viewer has a slider control, a combo box and 5 buttons. With the combo box the 
user can select one of the project’s images by its key and with the slider the user can 
determine the degree of blending between that image and the label image that represents the 
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result of the classification. If the slider is positioned completely to the right, Map Viewer will 
show only the label image, if the slider is completely to the left, only the selected image will 
be shown. In any position in between the two extremes, Map Viewer will show a blending of 
the selected image and the classification results. After the user sets the slider position, he/she 
must press the button Generate map for the blending to be executed. 

The label image generated as the output of the classification shows the regions filled with the 
same color defined for the nodes of the semantic network. If, however, the user clicks on the 
button Random Colors, Map Viewer will show the regions with random colors. To go back to 
the original colors (from the semantic net) the user must click on Generate map. 

With the buttons “+” and “-” the user can command zoom in and zoom out operations 
respectively.  

Finally, with the button Save map, the user can save the thematic map being visualized in the 
Map Viewer (as shown on the screen) to a image of type PPM (portable pixel map). 

7. Including New Operators 
As it has been said before (Chapter 2) the operators used by the system are external programs. 
This section provides the basic reference for including new operators in InterIMAGE. 

In both top-down and bottom-up processing steps the InterIMAGE’s control process visits all 
the semantic net nodes, executing the operators associated to each node. The operators are 
stand-alone external programs that generate as output a list of regions and a label image 
containing the regions. 

7.1. Top-Down Operators 
Any operator must have a description which determines how InterIMAGE will handle it. This 
description must be encoded into XML files with extension op, and placed at the folder 
./share/data/operators/, within InterIMAGE’s home folder. The operator’s XML description 
basically tells the system how to build the command line for executing the associated 
executable program. The text bellow is an example of an operator’s description 
<operator type=topdown class=gis name="TerraAIDA_ShapeFile_Import" 
  cmd="ta_shp_import \"@geoWest@\" \"@geoNorth@\" \"@geoEast@\" 

\"@geoSouth@\" \"@output@\" \"@class@\" \"@tmpdir@\" 
\"@mask_file@\" \"@shp_file_name@\" \"@shp_attributes_str@\" 
\"@label_img_res_str@\" \"@node_weight@\" " 

  runglobal=false tip="Import shape files regions into the analysis 
process" > 

  <attribute name=shp_file_name type=string label="Shape file name"> 
  <attribute name=shp_attributes_str type=string label="Shape file 

attributes" > 
  <attribute name=label_img_res_str type=double label="Label image 

resolution" value=0.5 > 
  <attribute name=node_weight label="Node weight" type=double 

value=1.0> 
</operator> 
 
The operator’s description defines a group of arguments that must be set somehow. Some of 
these arguments are automatically set by the system and are accessible only by including its 
name in operator’s cmd property. Others must both be present in the cmd field, and have an 
attribute tag that will define its properties.  

The arguments (automatically set by the system):  
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• geoWest, geoNorth, geoEast, geoSouth: geographic limits of the image data. 

• minRes, maxRes:  minimum and maximum resolution of the image data. 

• output: name of the output file with the description of the regions found by the 
operator. 

• input_file: name of the input image file (in the PPM format3) indicating the input 
image data operator should process. 

• mask_file: name of the mask file, a binary map (in the PBM format3) indicating the 
area in the input image data operator should process. 

• mask_x, mask_y: pixel coordinates of the origin (top left corner) of the input image 
data to be processed by the operator. 

• mask_size_x, mask_size_y: size of the mask file, in pixels. 

• tmpdir: path of the temporary directory, used by InterIMAGE to store intermediate 
results of the analysis process. 

• class: class of the concept node of the semantic network for which the operator was 
defined as the top-down operator. 

• fuzzysets: path of the fuzzy sets file, used by generic operators (see Section 4.3). 

The following attributes are set for each picture delivered to the operator. The following lines 
contain only the suffixes of the attribute names, in an actual operator definition they should be 
prefixed by the name of the image (attribute name of the corresponding parameter of type 
IMAGE in operator's file description). 

Picture-dependent attributes: 

• _key 

• _type 

• _file 

• _res_x, _res_y 

• _size_x, _size_y 

Besides the arguments automatically set by the system, the user can define operator specific 
attributes, which will be regarded as parameters that can be set in the Node Properties Panel 
of InterIMAGE’s Main Window (see Chapter 3). Such attributes must be defined through an 
attribute tag, as in the example above.  

7.1.1. Region Description File 

InterIMAGE expects as the output of a top-down operator, a description of the region 
hypothesis found by the operator, and a labelled picture with the spatial representation of the 
region hypothesis. 

The name and path of the output region description file is given by the attribute output, passed 
to the operator as a command line argument. 

The contents of the file should be a list of regions, described individually as XML region 

                                                 
3 The description of the format can be found at http://netpbm.sourceforge.net/doc/. 
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nodes.  The nodes must be delimited by <region> tags, and must have the following attributes: 

• class:  indicates the class of the region.  Only regions, which correspond to the class of 
the calling node, are transferred to the instance net. 

• id:  a numeric (integer) id of the region in the label image. The id is unique in the file 
(label image). Every pixel belonging to the region has the value id. 

• file:  the file name of the label image where the region is represented.  Several regions 
can use the same label image as long as there is no spatial overlapping and their id 
values are different. 

• file_geoSouth, file_geoWest, file_geoNorth, file_geoEast: describe the bounding box 
of the label image in geocoordinates (UTM projection). If the label image covers the 
same geographical area as the image data passed on by the core when calling the 
operator, these values should be exactly the same as the geoWest, geoNorth, geoEast 
and geoSouth command line arguments (see previous section).  

• name:  the name of the region.  It serves only for visualization purposes.  If no name is 
indicated, a name is generated automatically from class name and a sequential 
number. 

• llx, lly, urx, ury:  describes the bounding box of the region within the label image4. 
The pixel coordinates expressed by these values are relative to the label image, i.e. the 
origin of the coordinate system is the lower right corner of the label image.  If x and y 
define a pixel coordinate inside the region, then llx <= x <= urx and ury <= y <= lly. 

• geoNorth, geoSouth, geoWest, geoEast:  describes the bounding box of the region in 
geocoordinates4.  As this geographic bounding box is exactly on the region’s border, it 
is thereby half a pixel larger in each direction than the bounding box in pixels. 

• p:  a confidence value for the region hypothesis. The operator can define an arbitrary 
confidence value, from 0 to 1, to the regions found. This value can be further used in 
the bottom-up processing step for the decision over spatially concurrent hypothesis. It 
is not a mandatory attribute, and it can be set in the bottom-up processing, but it is 
important to notice that in the absence of a p value, or if the value is the same for 
spatially concurrent hypothesis, the system will decide on the regions in a random 
fashion. 

The region descriptions can also contain any other attributes defined and calculated by the 
top-down operator. These attributes can be used in the bottom-up process, for the decision 
over overlapping regions hypothesis.  

In the example below, the output of a top-down operator is shown. Four regions are defined. 
The attributes area, perim, large, small, s_index and assim have been calculated by the 
operator. 
<region id=1 class=Region llx=10 lly=59 urx=29 ury=18 

file=region.plm p=0.1 area=779 perim=120 large=41 small=19 
s_index=0.075 assim=1.158 /> 

<region id=2 class= Region llx=38 lly=59 urx=57 ury=18 file= 
region.plm p=0.1 area=779 perim=120 large=41 small=19 
s_index=0.075 assim=1.158 /> 

<region id=3 class= Region llx=66 lly=59 urx=85 ury=18 file= 
region.plm p=0.1 area=779 perim=120 large=41 small=19 

                                                 
4 Only one of the groups of attributes “llx, lly, urx, ury” or “geoNorth, geoSouth, geoWest, geoEast” needs to be 
present in the nodes’ descriptions. 
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s_index=0.075 assim=1.158 /> 
<region id=4 class= Region llx=10 lly=88 urx=29 ury=79 file= 

region.plm p=0.1 area=171 perim=56 large=19 small=9 s_index=0.071 
assim=1.111 /> 

 

7.1.2. Region Label image 

The region nodes in the region description file generated by the top-down operator reference 
(through the file attribute) a label image, where the respective regions are represented. 

Although each region in a region description file can be represented in a different label image, 
usually all the regions are represented in the same image file (label image). 

The image file should be in PGM or PFM formats5. In that file, each pixel belonging to a 
region must have the same value of the id of that region. All other pixels in the image should 
have the value 0 (zero). 

7.2. Bottom-Up Operators 
A bottom-up operator has the task of grouping the node list it receives as input, resolving, at 
the same time, spatial conflicts among overlapping concept hypothesis. Each group contains a 
quantity of instances particularly grouped together for a specific reason. 

For each group, the bottom-up operator must generate a label image (instance map) in which 
each node (instance) that belongs to that group must be depicted and identified by a unique 
label.  

The operator must also produce a label image (group map) where all the generated groups 
must be depicted and identified by its unique id. 

The regions related to the nodes (instances) validated by the operator must be spatially 
disjoint (for all nodes in all groups). 

A bottom-up operator must have a description file (op) similar to those of the top-down 
operators (see Section 7.1).  In the following lines an example of an operator description file 
for a bottom-up operator is shown. 
<operator type=bottomup class=bu name="Generic BottomUp" 
  tip="Select regions using a UPN command" 
  cmd="ga_bu_generic \"@input@\" \"@output@\" \"@cmd@\" 

\"@fuzzysets@\" "> 
  <attribute name=cmd label="Decision Rule" type=formula> 
</operator> 
 

The global attributes, those that are automatically set by the system, and can be used as 
arguments for the operator’s binary, are only two: 

• input: name of the input node list (a file with the description of the region hypothesis 
to be judged by the operator). 

• output: name of the output node list (a file with the description of the instance network 
nodes and of any node groups eventually created). This attribute is also the prefix of 
the images, label images, where the nodes and groups are represented. The instance 
network nodes must be represented in a file called [output].bu.node.plm, and the 
groups in a file with the name [output].bu.plm (the image files can be in the PGM or 

                                                 
5 The description of the format can be found at http://netpbm.sourceforge.net/doc/. 
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PFM formats6).  

The following lines are an example of input node descriptions, in a hypothetical input file for 
a bottom-up operator. 
<node id="1" class="Region" name="Region_002_001" addr="0x831a560" 

status="CI" llx="0" lly="99" urx="99" ury="0" size="9998" 
geoSouth="1100.00" geoNorth="1200.00" geoEast="1100.00" 
geoWest="1000.00" file_geoNorth="1200.00" file_geoSouth="1100.00" 
file_geoEast="1100.00" file_geoWest="1000.00" 
file="/tmp/4312/Scene/Region_002/0082-output.bu.plm"  /> 

<node id="1"  class="Region" name="Region_005_001" addr="0x82e6638" 
status="CI" llx="0" lly="99" urx="99" ury="0" size="9998" 
geoSouth="1000.00" geoNorth="1100.00" geoEast="1200.00" 
geoWest="1100.00" file_geoNorth="1100.00"  file_geoSouth="1000.00" 
file_geoEast="1200.00" file_geoWest="1100.00" 
file="/project/interimage/tmp/4312/Scene/Region_005/0090-
output.bu.plm" /> 

And the following lines are an example of an output node list, a result of the bottom-up 
operator processing. 
<group id="1" file="/tmp/4312/Scene/0098-output.bu.plm" 

file_geoSouth="1000" file_geoNorth="1200" file_geoWest="1000" 
file_geoEast="1200">  

<node id="2" addr="0x831a560" llx="0" lly="99" class="Region" 
urx="99" ury="0" file_geoNorth="1200.00" file_geoSouth="1000.00" 
file_geoWest="1000.00" file_geoEast="1200.00" p="1.00" 
file="/tmp/4312/Scene/0098-output.bu.node.plm" 
name="Region_002_001"/> 

<node id="3" addr="0x82e6638" llx="100" lly="199" class="Region" 
urx="199" ury="100" file_geoNorth="1200.00" 
file_geoSouth="1000.00" file_geoWest="1000.00" 
file_geoEast="1200.00" p="1.00" 
file="/project/interimage/tmp/4312/Scene/0098-
output.bu.node.plm" name="Region_005_001"/> 

</group> 

7.2.1. Node Lists 

The bottom-up operators receive as input a list of nodes. A bottom-up operator will process 
the node list to: 

a) instantiate the nodes; validate or negate the input node hypothesis and resolve spatial 
overlapping conflicts; 

b) generate a map (label image) from the nodes; 

c) merge the nodes into groups. 

The structure of the node description is the same for the input node list and for the output 
nodes. Single instance node descriptions are enclosed in a <node> tag, and node groups in a 
<group> tag. 

Nodes can have arbitrary attributes, but the following attributes are mandatory7: 

                                                 
6 In InterIMAGE, the PLM extension can refer to a PPM or PGM image file. It can also refer to a specific PAM 
format, designed to accept information with larger dynamic ranges. 
7 Only one of the groups of attributes “llx, lly, urx, ury” or “geoNorth, geoSouth, geoWest, geoEast” needs to be 
present in the nodes’ descriptions.  
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 class:  determines the class (concept) of the region associated to the node. 

 id:  the id of  the node. The pixels in the label image belonging to the region 
associated to the node must have a value equal to id. 

 file:  is the file name of the label image where the nodes’ regions are represented. As 
several regions can be represented in the same label image, the distinction among 
those regions is made by the region’s id. 

 llx, lly, urx, ury:  bounding box of the region in pixels within the label image file.  If x 
and y define a pixel coordinate inside the region, then llx <= x <= urx and ury <= y 
<= lly. 

 geoNorth, geoSouth, geoWest, geoEast:  defines the bounding box of the region in 
geocoordinates.  As this geographic bounding box is exactly on the region’s border, it 
is thereby half a pixel larger in each direction than the bounding box in pixels. 

 file_geoNorth, file_geoSouth, file_geoWest, file_geoEast: defines the geographic 
bounding box of the whole label image file. 

 name:  is the name of the region.  It serves only for visualization purposes.  If no name 
is indicated, a name is generated automatically from the class name and a sequential 
number. 

 addr:  the memory address (pointer) of this node.  This attribute should not be updated 
since it represents the memory area where the nodes attribute values will be 
allocated/read by InterIMAGE, its values should only be copied from the operator’s 
input node list. 

A bottom-up operator will process the input node list to generate the output node list and node 
groups. One can notice from the input and output node description files, given in the prior 
section, which the attribute addr does not change. InterIMAGE established the node addresses 
before writing the input node list file. Through that address, the bottom-up operator can obtain 
the needed information about the nodes, for the instantiation/falsification decision. Bottom-up 
processing can also change the node regions’ shape, and represent that change in the output 
label images. If a node contained in the input node list is not present in the output files (node 
description and label images), the system will consider it as a discarded hypothesis. 

8. Deployment and Installation 

The system and its source code can be downloaded from the InterIMAGE Project website 
http://www.lvc.ele.puc-rio.br/projects/interimage/, or from the SourceForge open source 
repository http://sourceforge.net/projects/interimage/. 

Once the user have downloaded and unpacked all InterIMAGE files, an executable file called 
interimage will be available in the InterIMAGE home directory (that can be freely defined by 
the user). 

Some basic operators (top-down and bottom-up are included in the system’s package. Other 
operators (source and executables) can be found at (http://www.dpi.inpe.br/terraaida). 

The user can also download some examples from the project’s website to get started with 
InterIMAGE. They can be found in the Documentation section of the site. 
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